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YOU’D BETTER SHOP AROUNDYOU’D BETTER SHOP AROUND  ::

Smart publishers
use every column inch
to tell our good story

By
Mark W.
Rummel

Fenton, MI

Mark worked at papers in Saginaw, Port Huron and the Thumb Area, 
plus served on the CPM Board. He and wife Sally even worked for 
The Walt Disney Company. He also opened and ran a successful 
restaurant for 17 years. Contact him: MarkWRummel@gmail.com

ABOVE, The Ad-Visor & Chronicle 
in  Marshall

ABOVE RIGHT, The Marketeer in Livingston County

ABOVE, The 
Marketeer in 

Livingston County

AT LEFT, The Ionia 
County Shopper’s 
Guide in Saranac

AT RIGHT, MailMax 
in Benton Harbor

Few words, but many messages this month, as “We let the 
images do the talking” about great self-promotion ideas!
Send me samples of your favorites.

9

Attending group meetings has changed … thanks to ZOOM.  
The upside is that within my organizations, there is more expo-
sure to instructors and professionals that normally would not 
have occurred. Recently, I've gathered more information on…

I was a student, an art teacher, a graphic designer, a 
writer and again a student. For info, PDFs of articles, 
or have ideas or comments, e-mail: 
hanrahan.ln@att.net  Ellen Hanrahan ©10/2022

Design TipsDesign Tips Ad Talk
with Ellen Hanrahant

Take care until next month…Take care until next month…

Blend Modes 
This technique allows you to enhance an image 
without leaving the page layout program. It’s a 
time-saver because the options are instanta-
neous—no need for Adobe Photoshop.
 Since I have my leaves, let’s see what Blend 
Modes can do. Same leaves, although I now 
cropped and made the file smaller. 
 I placed my image, selected it, went to 
Image>Copy, then Image>Paste in Place.
 From there it was a matter of going to 
Object>Effects>Transparency and choos-
ing one of the Blend Modes. It defaults to 
“Normal,” but not exactly sure what that is.
 My samples below are similar, but posi-
tioned just a bit differently. The top photo 
Blend Mode is Screen 100%, the bottom photo 
Blend Mode is Multiply 100%.
 There are a variety of other Blend Modes: 
Soft Light, Hard Light, Color Dodge, Color Burn, 
Saturation, Hue and more… worth a look at 
the capabilities of this function.

It’s no secret that a lot of major events (think 
Adobe—Lightroom, Photoshop, Creative Pro, 
etc.) offer free online events. My camera club 
has also been able to have professionals speak 
at our groups, no matter where they live. There 
is so much out there, unfortunately, time is still 
a factor. But these online events are but an 
additional source for graphic information.
 It’s been a year since InDesign Magazine   
became CreativePro Magazine and the top-
ics are much broader and cover a more diverse 
range of software. The real-world experts offer 
practical and valuable insight into their areas of 
expertise—and I recommend it! 
 Yes, I’m still trying to explore the Affinity 
programs, but it’s a time thing (and I’m sure I 
will get there, but there is soooo much infor-
mation!). 
 Here’s the link to CreativePro Magazine. 
The Premium Membership is just $78/year, 
and if you use coupon code FRIEND, you can 
get $10.00 off:  https://creativepro.com/sp/
become-a-member/
 In the meantime, I offer some tips I have 
gathered throughout the past few years.

InDesign All-Star Tips 
One piece of advice that I can give is to take 
some time to try one new function. Fifteen to 
twenty minutes can get you to see some of the 
other features that you “never” use.
 Placing a photo within a word reminded 
me of using headline type for a different 
look… and you can see that example below in 
“Custom Image Frames”…
 If you choose to use this method— simple 
word to contain your artwork—use a very 
heavy or solid typeface, preferably sans serif.
 I also added an outline and gave it a drop 
shadow. This would not only be my headline in 
an ad, but also my graphic.

Custom Image Frames
Try creating custom frames. You will remember my Type 1 font, Matinee, (that will be useless very 
soon). Anyway, I took that font, selected it, then under Type, I chose Create Outlines. Selected 
those outlines (no longer a font but shapes) went to Object > Pathfinder > Add (which com-
bines the objects into one shape) and now I was ready to open “Fall Leaves.” I am able to move 
the artwork with the Direct Selection Tool to get the best position (there are larger leaves in the 
foreground and I didn’t want to show them because I thought they might be harder to recognize.
 I used the same image of leaves that you see in column 2 above, but this time I arranged the 
image so the smaller leaves in the background would fit into my text outline. To me the larger 
leaves in the image would be a little more confusing (it was a matter of “scale.”)
 I did not crop the photo, because I sometimes need the ability to change the position (if I have 
a lot of room, I could always enlarge the word and increase the leaf sizes. 

 This would probably be an opportunity 
to spend fifteen or twenty minutes to see 
what these various blend modes offer.
 Anytime I don’t have to leave my page 
layout program, the easier and faster it is 
for me. Trust me, we’ve come a long way 
since the early days of “desktop design.” 

Type to Vector… or Not 
Back in the day, it wasn’t always easy to find 
art that would work in the small ads that 
made up a great portion of our papers.
That’s when I discovered 
vectors… and dingbats!
 Bursts were a big thing 
and I was always looking 
for ways to change them up
… LTR Salmiak Catchwords!
 I have shown the original glyph, then 
layered, turned and modified below. 
Other fonts can be a source 
for bursts… explore… 
then add any final 
versions to a library 
for future 
uses!

t

tt tt50% 
 OFF

I turned this
dingbat flower into a vector. Enlarge (172 
points), create outlines and color in the 
shapes for instant graphics!
 In this case the outlines
were not connected, so
I created one shape
with the pen tool,
colored it, rotated it and
added a basic feather
effect (see color "swatch"
next to flower). I then placed
all the shapes behind the
petals for a "watercolor"
effect…saved to a library for future use.
 The flower itself was just an outline, but 
impact was added with various gradient 
color swatches. The vector aspect allows 
me to scale the art without degradation.

Final thoughts… 
Adobe MAX–The Creativity Conference will 
be October 18–20, 2022—both in-person 
and online this year! 
 The virtual event is still FREE and covers 
the gamut—Photoshop, Lightroom and 
Lightroom Classic, Video and all things 
Adobe. To find out about the virtual event:
https://max.adobe.com/virtual-max/
 Not sure I will be able to attend virtually. 
I will have to see if I can have access to the 
events other than during those dates as I 
will be out of the country (sorry, I have my 
priorities, especially when I have to deal 
with spotty WIFI… maybe little umbrella 
drinks would help!) It’s always something! 
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Ernesto Sirolli, most adequately pointed out 
when he said, “The future of every community 
lies in capturing the passion, imagination, and 
resources of its people”. Regardless if you are a 
business or community, conveying your passion, 
your imagination, and your story, complete 
with a compelling emotional attachment is a 
significant tool not to be over-looked when 
attempting to sell your brand image. They say 
a picture is worth a thousand words, so always 
attempt to paint that compelling picture on the 
minds of your citizens and customers.
 
In 2006, a journalist attempted to show the 
power of storytelling. He bought 200 random 
insignificant items off the internet, spending 
a total of $198. He then contacted and then 
sent the 200 items to 200 different writers, 
authors and publishers asking them to write 
an emotional appeal or story about the 
object that was sent to them. After getting 
the stories back, he then went back on the 
Internet, promoting and marketing those same 
200 items. This time however, he attached 
the compelling and emotional connections 
described by 200 different authors along with 
the previously random and insignificant items.  
Those 200 items sold for over $8000, or about 
a 4000% profit.
 
Storytelling matters, it matters a lot. What is 
the story that your business or community 
is selling and telling? What is the emotional 
appeal that you are providing to your citizens, 
potential citizens, and potential customers? To 
transform to the fullest, you must have a story 
that connects emotionally.  A story that not only 
transforms the community, but also transforms 
the thinking of those in the community. After 

all, what is a community without its citizens? It 
has been said, the condition of your downtown 
becomes the condition of your community. 
You can’t change the heart and soul of the 
community without changing the heart and 
soul of those people that live in the community. 
You must help the citizens build the belief they 
are worthy of more than currently exists. You 
must instill the pride that is needed to assure 
powerful transformation.  
 

Have you ever wondered why 
some communities seem to 

always get it right or just seem 
to figure it out, while others 

seem to wander aimlessly from 
study to study and from failed 
attempt to failed attempt?  It 
isn’t by accident; it is by a lack 

of direction. They don’t confuse 
activity for productivity, 

and they have a plan.  Zig 
Zigler rightfully said, “Lack of 
direction, not lack of time, is 

the problem. We all have 
24-hour days.”

 
It doesn’t stop there however, once you have 
built the compelling and emotional story that 
connects to readers, viewers, and so forth, then 
you must attach the theme of that story to 
everything you do.  That story becomes a part 
of your brand, it becomes a part of everything 
you do. That theme is then woven through your 
brand, your marketing, your advertising, and 
all your content marketing efforts.
 
Let me use the words of others much smarter 

than I to close this week’s column. Seth Godin 
said, “A brand is the set of expectations, 
memories, stories and relationships that, taken 
together, account for a consumer’s decision to 
choose one product or service over another.” 
As you build and convey your community or 
business brand, you can expect just as Howard 
Schultz expressed, “If people believe they 
share values with a company, they will stay 
loyal to the brand.”  It is so important that a 
community or business control the message 
that is not only conveyed, but that is felt in the 
marketplace. Scott Cook said, “A brand is no 
longer what we tell the consumer it is—it is 
what consumers tell each other it is.”
 
A community MUST build, promote, and 
repeatedly convey their brand non-stop. They 
must tell the story that controls the narrative 
of their community. If you aren’t conveying 
a message that brands and promotes your 
community or business, rest assured that your 
competitors are.  Oftentimes the difference 
between successful communities or businesses 
and those not as successful is their story. 
Emotional connections are critical, create 
your emotional connection and start elevating 
toward a brighter future.  
 
John Newby is a nationally recognized 
Columnist, Publisher, Community, Business, 
Media, Strategic Consultant & Speaker. His 
“Building Main Street, not Wall Street,” column 
is enjoyed by 60+ communities around the 
country. As founder of Truly-Local, he assists 
community and business leaders in building 
synergies that create vibrant communities. He 
can be reached at: info@Truly-Localllc.com.

Building Main Street, 
not Wall Street
Storytelling and the Imagination of Your Brand? 
- John Newby
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  by Kevin Slimp
  kevin@kevinslimp.com

Excuse my repetition, 
but for those who didn’t 
read my column last 
month titled, “Planning 
for Adobe Type 1 Co-
nundrum in January,” 
there is a storm brew-
ing, and it’s not coming 
from the Gulf of Mexico. 
It’s from the tall tower 
on Park Avenue in San 
Jose, California, home of 
Adobe, Inc.

Please forgive this bul-
let list of repeated infor-
mation from my previous 
column to get everyone 
up to speed:

• Your Type 1 fonts won’t 
work in Adobe software 
releases beginning 
January 2023. 

• Previous files created 
with those fonts won’t 
open correctly in 
new Adobe releases 
starting January 2023.

• January 2023 is a few 
weeks from now.

Before spending a 
frantic night replacing 
fonts, let me share some 
information to ease every-
one’s minds. Adobe says 
the Type 1 issue applies 
strictly to new releases be-
ginning in January 2023. 
It does not affect support 
for Type 1 fonts in earlier 
releases. The problem, as I 
see it, is that CC (Creative 
Cloud) applications auto-
matically update for most 
of us, so we have all the 
latest features and don’t 
see conflicts with updated 
operating systems. This 
means it won’t be long be-
fore the Type 1 issue hits 
home for most of us.

Okay, now everyone is 
up to speed.

Did I mention that 
my inbox and voicemail 
have filled over the past 
few weeks with messages 
from publishers con-
cerned about the upcom-
ing tsunami? If you’ve 
done nothing to prepare, 
you’ve got some work to 
do before the end of the 
year, lest you spend your 
holiday season frantically 
getting fonts in order.

One PDF file sent to me 

by a publisher this week 
was representative of 
many of the files I’ve been 
seeing. There were 73 – 
that’s right, 73 – Type 1 
fonts included in the file. 
That means the InDesign 
document that exported 
this PDF included 73 Type 
1 fonts. Sure, many prob-
ably were embedded into 
ads that came from adver-
tisers and likely will not 
cause any issues when 
opening and printing the 
file. However, you can bet 

Even more news about Adobe 
Type 1 and your newspaper

There’s no need to panic, but you need to prepare for January

If you see a red “a” symbol and/or the “Type: Type 1” listing 
in your Acrobat Properties window, you know there are Type 
1 fonts in the PDF file. While this might not be problematic, 
creating a PDF from an InDesign document, then checking 
its properties in Acrobat is a good way to see how many 
Type 1 fonts you have in an InDesign document.

Finding the scary-looking “a” with a yield symbol in the In-
Design “Find/Replace Font” window means you have fonts 
that need to be replaced before January. Otherwise, some-
one is going to have some late nights.

(Contiued on page 6)
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that some of these soon-
to-be-offending fonts 
came from paragraph 
styles, headlines, librar-
ies, and other far corners 
of the InDesign desktop.

It’s turning out to be a 
busy fall for me, working 
with dozens of newspa-
pers on various projects 
ranging from quick con-
sults to total redesigns. 
That means I’ve been 
looking over a lot of pag-
es, looking for potential 
areas of improvement 
and problems. And what 
am I seeing? Along with 
the usual assortment 
of editorial and design 
quandaries, I’m finding 
a lot of Type 1 fonts. Yes, 
the InDesign desktop is 
a veritable potpourri of 
Type 1 hiding places.

How do you know if 
you have a Type 1 prob-
lem in an InDesign file? 
There are several places 
to begin your search:

• Open the 
“Find>Replace Font” 
window in InDesign 
and look for “a” 
symbols with yellow 
yield signs next to 
them. When you find 
them, you will find 
fonts that should be 
before January. 

• While in the 
“Find>Replace Font” 
window, look for light 
gray symbols with a 
small “a” on the left 
edge. These indicate 
graphics (EPS, PDF, 
etc.) that may or may 
not be problematic. If 

your paper created the 
graphic using this font, 
be sure to replace that 
font before trying to 
use it in the future to 
create new files. 

• Create a PDF file 
of your InDesign 
page, then look in 
the File>Properties 
window. Click on the 
“Fonts” tab and look 
for Type 1 fonts in 
your list. If you see 
familiar font names 
and have a good idea 
that they’re not coming 
from submitted PDFs 
or other graphic files, 
then you’ve probably 
got Type 1 fonts 
floating around in your 
paragraph styles and 
libraries.

What can you do to 
be ready when January 
comes? First, I suggest 
you go into your Adobe 
Creative Cloud prefer-
ences and ensure your 
apps don’t update auto-
matically.

Because things never 
go perfectly, versions 
of InDesign and Photo-
shop will eventually get 
updated by necessity or 
accident, and it’s vital to 
get your fonts in order as 
soon as possible.

Look at the Ac-
robat properties 
(File>Properties) and 
search for Type 1 fonts in 
your documents. Begin 
replacing them imme-
diately with OpenType 
versions of the same or 
different fonts.

Educate agencies and 
others who send PDF 
files to you concerning 
the impeding Type 1 
issue. They might not un-
derstand what’s coming 
and will appreciate you 

giving them an advanced 
warning.

Let’s face it, whether 
you update to the latest 
version of InDesign and 
Photoshop automatically, 
or wait a few months, 
eventually, you will face 
the Type 1 conundrum, 
and now is the time to 
prepare. You will eventu-
ally update your CC ver-
sion even if you turn off 
the auto-update feature in 

Creative Cloud. If you’re 
using Type 1 fonts in the 
interim, your files won’t 
open correctly when that 
time comes to update 
your Adobe products.

Now, breathe easy. 
There’s no need to stay up 
late tonight unless you’ve 
waited until January 1 
to read this. In that case, 
Happy New Year.

Finding the scary-looking “a” with a yield symbol in the In-
Design “Find/Replace Font” window means you have fonts 
that need to be replaced before January. Otherwise, some-
one is going to have some late nights.

The light gray “a” symbol in your InDesign “Find/Replace 
Font” window indicates Type 1 fonts in graphics in your 
document. These might or might not be problematic, but 
should be looked into before getting a surprise at deadline.

Adobe says the Type 1 issue 
won’t effect files created and 
opened in versions of Adobe 
products released before 
2023. You might consider 
turning off Auto-update for 
all applications in your Cre-
ative Cloud preferences until 
you’ve had time to deal with 
most of your Type 1 issues. 
Eventually, due to operating 
system requirements or a 
need to access new features, 
you will want to update your 
applications.

newspaperacademy.com

Kevin Slimp - Contiued from page 5
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Ad - Libs
A Key 
Question: 
What’s Next?

“That turned out to be great advice. I sat 
there and gave myself a good talking-to. 
Nothing could change the fact that my sales 
presentation had fallen flat. But what I could 
change was my approach to that reality. 
Instead of giving up on that new business 
prospect, I dove back into my notes, reflected 
on our conversation during my presentation, 
and developed another campaign proposal. 
The new ideas were accepted, and I’m happy 
to say that company became a consistent 
advertiser.

 
“What I learned is that it’s important to look 
ahead,” Gregory said. “Think beyond what is 
happening right now and be ready to change 
directions.”

 
Gregory’s story reminds me of an old Bob Hope 
line in a movie I saw on TV: “All I’ve gotta do 
now is figure out what I’m gonna do now.” 
If we look beyond the double-talk of that 
gag, we’ll see some real truth. Our biggest 
challenge is often figuring out what to do next.

In fact, I believe one of the most important 
business questions we can ask is, “What’s 
next?” These two little words represent a 
deliberate focus on the future. This is especially 
true in a profession like marketing, which 
demands constant evaluation and adjustment. 
Considering the current situation as a new 
starting point, what’s the next step? If we 
expect to make any progress at all, there 
should always be another step.
 
Let’s say you make a big sale. I heartily 
recommend that you celebrate your success 
and share the glory with your teammates. But 
after the high fives at the goal line, it’s not a 
good idea to camp out for a long time in the 
end zone. Things will not stay like that forever. 
The game goes on. There’s a next step.
 
What if consumers don’t respond to the 
current offer being made in an advertiser’s 
ads? Do you keep running the offer again and 
again, hoping that something will change on 
its own? Or do you analyze the plan and make 
some adjustments?

If you’re a manager who notices that morale 
in your department is sagging, what can you 
do to make things better? (Please don’t say, 
“team building activity.”) Do you hope the 
situation will go away “when the economy 
improves?” Or do you take the initiative with a 
little inter-department research to get to know 
your team as individuals? Let them help you 
determine the next step.
 
It’s not complicated. It’s simply a matter of 
evaluating the current situation and asking 
yourself, “What’s next?” Keep answering that 
question and you’re on your way.

 
(c) Copyright 2022 by John Foust. All rights 
reserved.
 
John Foust has conducted training programs 
for thousands of newspaper advertising 
professionals. Many ad departments are using 
his training videos to save time and get quick 
results from in-house training. E-mail for 
information: john@johnfoust.com

BY JOHN FOUST

Gregory talked to me about a lesson he learned in his early days of selling advertising. “In one of 
my first presentations, the prospect rejected my ideas for a new campaign. Back at the office, my ad 
manager must have noticed the stunned look on my face. When I told her what happened she didn’t 

want to know the gruesome details. She just asked, ‘Okay, so what’s next?’
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My years at the University of South Dakota 
were not exceptional. I was never a great 
student and depended on my speech and 
history courses to raise my overall grade 
point. 

The university helped me financially with 
some scholarships and a part-time position 
in the USD News Bureau.

I switched my major from broadcasting to 
history my sophomore year and Dr. Herbert 
Schell, the head of the department, became 
my guidance counselor. I have long said 
that journalists are the first writers of 
history and thank Schull and USD’s history 
professors for inspiring me.

It was also during that second year that I 
pledged the South Dakota chapter of Beta 
Theta Pi fraternity. Many great friendships 
came out of my living in the “Beta Barn” 
fraternity house on Vermillion’s Main 
Street. Among them was Gary Whidden, my 
college roommate, Best Man and Connie 
and my business partner when we started 
the Golden Shopper. Gary married Diane 
Cox while he was living in Sibley.

Another was John Thietje, who transferred 
from the University of Minnesota that same 
year and who remains one of my closest 
friends today.

The brotherhood gave me two opportunities 
to grow in ways that later helped me in the 
publishing business. For two years I served 
as the chapter’s alumni secretary, a position 
that made me responsible for putting 
together “The Dragon’s Roar”, an eight-
page tabloid mailed to some 700 alumni. 
The second was electing me rush chairman 
my final year in college. That recruiting 
experience gave me an enhanced education 
in the art of salesmanship.

Beta Theta Pi’s national organization was 
run by a group of older alumni. District Chief 
Peter F. Greiner, a Minneapolis attorney was 
in charge of the South Dakota, Minnesota 
and North Dakota chapters. I was always 
impressed by his visits and often thought 
it would be exciting to someday be a Beta 
District Chief. Years later I learned to be 
careful of what you wish for. 

The South Dakota Beta chapter was a tight 
knit organization. We were very secretive 
and wouldn’t even reveal the color of the 
living room carpet when outside the house. 
But for some reason Tom Brokaw, who 
later became NBC’s Today Show host and 
evening news anchor, found a way to be 
a regular guest. He’d had grade problems 
earlier while attending another college and 
his father, fearing more poor grade reports, 
made him promise not to join a fraternity 
at USD.

I got into a conversation with Tom one 
evening soon after he was hired parttime by 
KTIV as a weekend newscaster. He told me 
how he was going to parley that KTIV job, 
after graduation into a position at the NBC 
television station in Omaha, then move to 
Los Angles and then on to the NBC network. 
And he did, just as he said.

I, meanwhile, was still bouncing around 
to find my role in life. But circumstances 
are God’s sealed orders and, running out 
of money close to the end of the school 
year, I found myself attending school in the 
morning and working afternoons, evenings 
and weekends at WNAX 5-State Radio in 
nearby Yankton, SD.

WNAX was big league radio in the same 
class as WHO in Des Moines and WCCO in 
Minneapolis. I learned a great deal while 
working there as the only advertising copy 
writer, Continuity Director and sometimes 
staff announcer.

Elmer Smith was the station manager 
who hired me and Jack Bruce the program 
director. Bruce’s office was next to mine, 
and he provided me many opportunities 
and challenges that helped me grow 
professionally. 

A HISTORY OF THE WAGNER FAMILY 
PUBLISHING BUSINESS CHAPTER THREE 
It Was What We Didn’t Know That Counted
 

From College to Marriage

Peter Wagner
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Occasionally, when News Director Bob Hill 
took a day off, I would fill in for him. That 
meant being at the station before 5:00 in the 
morning to prepare for the first on-the-hour 
newscast of the day. I once mispronounced 
a word on that early newscast and heard 
about if from relatives and friends living in 
four cities in three states.

There was a close bond among the WNAX 
staff, and I especially enjoyed working with 
two men my age who covered the night 
shift. If I stayed until they finished work, the 
three of us would drive across the big South 
Dakota/Nebraska bridge on the other side of 
the river to enjoy a late supper and talk shop 
way into the night.

Pete Peterson was the station’s Promotion 
Manager. For a few weeks, when he was 
sick, Mr. Smith asked me to fill in for him. 
Peterson had a spacious office on the second 
floor filled with all sorts of typesetting 
equipment. It was one more opportunity to 
prepare for my eventual lifetime publishing 
career.

My only scheduled broadcast time was 
Sunday morning and afternoon. The morning 
hours were filled with prerecorded religious 
programs such as Billy Graham’s “Hour 
of Decision” and the Christian Reformed 
Church’s powerful “Harvest Time”. I would 
often sit, listening to those programs, 

wishing I could be associated with some 
evangelistic organization. It was another 
one of those “be careful what you wish for” 
moments.

But the very best thing about WNAX was 
meeting my future wife Constance Jeanne 
Johansen. Connie was the secretary in the 
farm department, the station’s biggest 
revenue source, with Farm Director Rex 
Messerschmidt, Associate Director Lyle 
Hansen and roving reporter George B. 
German. She took dozens of lengthy, detailed 
calls from livestock auctions and news 
sources every day and her organizational, 
shorthand and typing skills proved very 
useful.

But the transcription of those calls must 
have required the use of dozens of wooden 
pencils.

Connie’s office was at the far end of the 
hall from mine, and I had the only pencil 
sharpener on the first floor. Every day, soon 
after I arrived from my morning classes at 
USD, I would hear the click, click of the heals 
of this beautiful redhead coming down the 
hall.

Once in my office, she would stand at my 
sharpener with her back to me and grind 
new points on a huge handful of pencils.

Before the first week had passed, I invited 
her to a fraternity dance that weekend at 
Kelly’s Cove in Yankton. When we arrived 
at the party that Saturday night, I learned 
Connie was the girl a fraternity brother’s 
Yankton girlfriend had been attempting to 
line me up with for the last few months. I 
am convinced our marriage is a God thing 
and when I wouldn’t listen to the girlfriend, 
God made sure I had reason to go to work 
at WNAX.

I only worked at WNAX for eight months. 
But during that time I found myself totally 
accepted by Connie’s parents, Ernie and 
Effie (Larsen) Johansen and tolerated by her 
younger sister, Cindy.

Connie’s father was a master custom 
cabinet maker and her mother a marvelous 
cook, a talent she passed on to her daughter. 
I was soon a regular guest at their dinner 
table but not always the only one. My wife 
was blessed with many cousins, aunts and 
uncles and various ones would often stop by 
for a visit. Effie never let anyone in the door 
without putting food on the table. That was 
another lesson my redhead carried into our 
marriage.

That fall Connie and I decided to get married. 
We’ll share more about our wedding, move 
to Sioux Falls and then Sibley in the next 
chapter.

Peter Wagner Story Cont.
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